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Introduction The Adobe® InDesign® CS2 Classroom 
in a Book™ course presents students with 
tips, techniques, and solutions for using 
the Adobe InDesign software.

The Instructor Notes are intended to 
complement the information in the 
Adobe InDesign CS2 Classroom in a 
Book®. The information is organized to 
follow the sequence of instruction in each 
lesson. 

About the workbooks
It is recommended that each student in 
the class have an individual copy of the 
Adobe InDesign CS2 Classroom in a Book. 
Students will use this book as you lead 
them through projects. Additionally, the 
book can be used as a self-paced tutorial.

You can buy more copies of the Adobe 
InDesign CS2 Classroom in a Book for 
your students, or you can refer them to a 
local bookseller to purchase the book. For 
more information, call Pearson Education 
at 800-922-0579.
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Course strategy
If you’re teaching a 15-week course, you 
can teach approximately one chapter of 
this book per class. The book numbers 
14 lessons plus an introductory tour. So 
depending on the actual length of your 
course, you may want to combine some of 
the lessons with related lessons in a single 
class. For example:

The first three lessons provide instruction 
on the essentials for Adobe InDesign, 
while Lessons 4 and 5 cover a number of 
aspects of importing and editing type.

We recommend that, at an absolute 
minimum, you teach the Quick Tour 
and Lessons 1 through 8 and also 
Lesson 12. Most of the basic Adobe 
InDesign features and the InDesign work 
environment are covered in these lessons. 
These aspects of InDesign need to be 
understood by all students who will need 
to use InDesign.

In addition to using Adobe InDesign 
Classroom in a Book to teach beginning 
and intermediate Adobe InDesign classes, 
you can use individual lessons to teach 
specific topics, as suggested below:

To focus on transparency, use Lesson 10.

To focus on text and tables, use Lessons 4, 
5, 7, and 9. 

To teach color, use Lesson 6.

Managing student projects
One way to simplify file storage and 
retrieval in classroom situations is to ask 
students to create a folder on their hard 
disks, name it (Student name’s) Lessons, 
and then copy each project folder into 
the main Lessons folder. Having students 
keep all their working files in their own 
Lessons folder makes it easy for you to 
clean up files when a class is over.

Additional resources
Instructors and users of Adobe InDesign 
rely on various resources to supplement 
their knowledge of the program. You may 
find the following resources useful to 
explore.

Adobe InDesign CS2 User 
Guide
This guide contains feature descriptions. 
It’s useful for learning about areas of the 
program that are outside the scope of the 
Classroom in a Book.

InDesign Help
The online Help installed with InDesign 
contains a complete descriptions of all 
features, including topics not covered in 
the User Guide. You can view online Help 
by choosing Help > InDesign Help. (In 
Windows, you can also press F1 to access 
InDesign Help).
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Application CD
The Adobe InDesign application CD also 
contains additional information.

Adobe Web site
The U.S. Adobe Web site at 
http://www.adobe.com contains a variety 
of Illustrator training and support 
resources. Many step-by-step tutorials are 
available at the Adobe Web site, and the 
User-to-User Forums are a great place for 
students to learn from more experienced 
users.

Adobe Online
Adobe Online is a quick and easy way to 
reach Adobe resources at the Adobe Web 
site, including training resources and 
downloadable updates to Illustrator. You 
can start Adobe Online by clicking the 
icon at the top of the InDesign toolbox, 
or by choosing InDesign Online from the 
Help menu in InDesign.

Adobe Certified Expert (ACE) 
program
This program is designed to validate an 
expert skill level of Adobe  
InDesign CS2. Careful testing of 
candidates ensures that each ACE has 
demonstrated expert product knowledge 
of the current release of Adobe InDesign, 

resulting in increased marketability and 
an added credential.

Training for the ACE program is 
available through Adobe Certified 
Training Providers and self‑study. For 
more information about this program, 
send e-mail to certification@adobe.com 
or visit the Adobe Web site at 
http://www.adobe.com.

Several resources mentioned here are 
available directly from the Help menu 
within InDesign, such as online Help and 
Adobe Online.
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Lesson 1: Getting to Know  
the Work Area
This lesson provides an overview of the 
functionality of InDesign. By the end of 
this lesson, students should understand 
that they can use InDesign to create 
page layouts using a variety of elements. 
They should also understand the overall 
interface of InDesign, including, how to 
access palettes, where tools are located, 
and how objects are placed inside of 
frames.

Working with tools
Page 47-48 Note that many of the tools 
have pop-up options. Tools you need 
to access may be hidden beneath other 
tools. A complete listing of all the tools, 
including available selections from each 
tool group, is provided on page 47. Also, 
many tools have keyboard shortcuts that 
you can use to quickly activate them. 
These are listed adjacent to the tool name 
in the graphic on this page.

Applying Color
Page 49 This section provides an 
introduction to applying color to objects 
using InDesign. It is not intended to be 
a comprehensive examination of colors. 
See Lesson 6 for a more detailed look at 

creating, saving, and applying colors and 
gradients.

New Window
Page 50-51 It is important to note that 
new windows are not the same as new 
documents. You can create multiple 
views of the same document, opening 
new windows as necessary. Each window 
is simply a separate view of the same 
document.

Palettes
Page 53 All palettes are organized under 
the Window menu. Your students should 
never be lost looking for palettes once 
they understand this key concept.

Workspace Management
Page 56 If you have multiple groups of 
students using the same computers, you 
can have each student create and save 
their own workspace. You can also have 
them restore the default workspace if 
needed.
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Zooming
Page 59 While the Zoom tool works well, 
you can work more efficiently by holding 
down the modifier keys to temporarily 
activate the Zoom tools. Use Command 
+ Spacebar (Mac) or Ctrl + Spacebar 
(Windows) to temporarily activate the 
Zoom tool, which allows you to quickly 
increase your magnification without 
having to switch tools.

Scrolling
Page 64 Use the space bar to temporarily 
activate the hand tool to scroll through 
a document. When entering text, using 
the Alt (Windows) or Option key (Mac 
OS) to temporarily access this tool, rather 
than needing to switch using the Tools 
palette.

Layers
Page 66 If you are familiar with layers in 
Photoshop or Illustrator, they operate in 
a very similar manner within InDesign. 
You will want to encourage students to 
organize complex projects using layers, 
otherwise it becomes unnecessarily 
difficult to select and manipulate objects.

Context Menus
Page 69 Context menus are widely used 
throughout InDesign. Use your right 
mouse button to access these throughout 

InDesign. You’ll find these helpful menus 
let you avoid the need to remember 
a large number of key commands or 
frequently search for items in the menus.

Questions
1 What is the difference between using 
layers and using the send or bring 
commands?

2 How can you organize your palettes?

3 If you are looking for a tool and it is not 
visible, where might it be located?

Answers
1 Stacking order exists on each layer, as 
you can bring items to the front of a layer 
(or the back) by changing the stacking 
order. But event the topmost object in a 
layer will still be behind any objects in 
layers that are located above the object. 
Together layers and stacking order 
determine the visibility of objects.

2 You can create custom groups of 
palettes by moving them into their own 
palettes. You can also create your own 
custom workspace.

3 Some tools are nested, as they are 
located behind other tools. You must click 
and hold down on a tool to select any 
tools that are nested behind it.
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This lesson provides the foundation for 
creating new documents. This lesson 
is focused on how to create custom 
page sizes, defining a master page, and 
applying master pages to a document 
page.

Document Presets
Page 77 You are not required to create a 
document preset before creating a new 
document. You should create these only if 
you will be frequently re-using a custom 
page size.

Master Pages
Page 79 Understanding of master pages 
is critical for anyone who will be creating 
longer documents. They avoid repetitive 
formatting tasks, and are widely used by 
anyone creating longer documents.

Guides
Page 80-85 You can place guides on either 
document or master pages. All guides can 
be edited on document pages, whether 
they are page guides, ruler guides, 
margins, or columns. It is not necessary 
to edit them on the master page if they 
only need to be modified in one instance 

on a specific document page due to a 
specific, unique page layout.

Placeholder Frames
Page 88 It is not necessary to create 
placeholder frames before importing 
objects. While this lesson uses a 
foundation of placeholder frames to 
create a consistent layout, you can also 
create the frames at the time you import 
graphics and text.

Text Linking
Page 97, 102-103 This is another key 
concept, as any document that has text 
running from one page to another will 
need to use links. Be certain that your 
students understand this concept before 
moving into other longer documents.

Adding Pages
Page 101 As an alternate, you can drag 
master pages from the top of the Pages 
palette to the bottom of the palette to add 
pages into a document.

Lesson 2: Setting Up Your Document
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Questions
1 When are master pages most useful?

2 Where can you create guides that will 
appear on all pages?

3 How can you avoid repetition when 
creating documents that will all be the 
same size?

Answers
1 When you have long documents with 
repetitive formatting, such as running 
headers, running footers or a consistent 
layout used on a number of pages.

2 You can create a master page with 
guides.

3 You can create a Document Preset or 
you can create a template document.
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This is an important chapter, as all objects 
are placed within frames. Text, graphics 
and even tables are placed inside of 
frames. So getting familiar with how 
they operate enables your students to 
more efficiently work with both text and 
graphics.

Cropping
Page 122 Changing the crop of an image 
does not change the image itself. The 
visible area is all that is changed.

Select and Direct Select Tools
Page 123-125 It is important to understand 
when to use the Selection tool as opposed 
to the Direct Selection when looking to 
manipulate the location of an image. Use 
the Selection tool to move an image and 
frame together, while you use the direct 
select to manipulate the content.

Text Wrap
Page 126 While this exercise has students 
wrap text around an irregularly shaped 
polygon, you will most frequently use the 
second button in the Text Wrap palette 
to wrap around the bounding box of an 
object. Text wrap does not require an 

object to be positioned above an object, 
and applies to text regardless of the layer 
on which an object is placed.

Frames
Page 128 Remember that frames placed 
on document pages let you place either 
text or graphics into them, so the tools 
you use to create frames on document 
pages are quite flexible.

Duplicating Objects
Page 135 You can hold down the Alt 
(Windows) or Option (Mac OS) key 
while dragging an object to duplicate it, 
or you can also use the Step and Repeat 
command if you need to create multiple 
objects. Of course, copy and paste also 
works.

Lesson 3: Working with Frames
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Questions
1 What are the differences between the 
Selection and Direct Selection tools?

2 Why should you use the text inset 
command?

Answers
1 The direct select tool is used to select 
individual anchor points, line segments 
and the content of picture frames. Use 
the selection tool to manipulate an entire 
frame.

2 Use the text inset when you have a 
border around the edge of a text frame or 
if a text frame has a colored background. 
This provides for distance between the 
edge of the frame and the location of the 
text within the frame.
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Because most InDesign documents 
include text and graphics that are created 
using other programs, you should become 
familiar with the process of importing 
text. 

Missing Fonts
Page 144 InDesign provides a number of 
additional ways to indicate that fonts are 
missing. The listing of a missing font in 
the Character palette is provided inside 
of parenthesis, a Missing listing is added 
to the Font command under the Type 
menu and fonts are also highlighted in 
pink when displayed in the layout. There 
should be no mistaking missing fonts 
in your documents. To avoid missing 
fonts, use the Package command when 
assembling a document for delivery to a 
print service provider or confirm that the 
person with whom you are sharing the 
document has the necessary fonts. Fonts 
are software, and they should only be 
installed within the rules outlined in the 
licensing agreements.

Creating Text Frames
Page 145 Pay close attention to the 
cursor icon when creating text frames. 
The square icon surrounding the cursor 

indicates that a box will be created when 
you click. If only the I-beam is visible, 
then the cursor will create an insertion 
point in an already existing frame.

Styles
Page 152 This section provides a quick 
overview of the benefits of using styles to 
apply multiple formats to type in a single 
step. Lesson 7 covers styles in greater 
depth.

Flowing Text
Page 147-149 One of the most common 
tasks is to import text and flow it from 
one page to another. Be certain that 
students understand automatic flowing 
of text so that they can import larger 
passages of type without having to 
manually add each page in the document.

Columns
Page 159-160 As a variation, you can 
create one box and divide it into multiple 
columns using the Text Frame Options 
command, and then add a text wrap to 
the picture of the biker. It is often easier to 
create one box and divide it into multiple 

Lesson 4: Importing and Editing Text
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columns as opposed to creating separate, 
linked boxes.

Missing Fonts
Page 168 While the exercise calls for 
replacing the missing fonts, it is more 
typical that you would locate the missing 
fonts and install them on your computer.

Story Editor
Page 176 The Story Editor may be useful 
for students producing documents that 
include a great deal of linked text. The 
Story Editor makes it much easier to work 
with longer sections of text.

Text on a Path
Page 177 Text can be placed on almost any 
path using the Path Type tool. There is no 
special type of path required, but you do 
need to choose the Path Type tool to add 
text to a path.

Questions
1 How can you spell check all the text in a 
document?

2 Does text on a path require a special 
type of path?

3 What is the difference between a 
character style and a paragraph style?

Answers
1 You can choose the Document option in 
the Check Spelling dialog box (accessed 
from the Edit menu).

2 You can use any path, but you need the 
Path Type tool to add text to the path.

3 Paragraph styles apply to an entire 
paragraph, while Character styles only 
apply to text that is selected.
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This chapter provides an introduction 
to many of InDesign’s more refined 
typographical features such as kerning, 
tracking, and drop caps. 

Line and Paragraph Spacing
Page 185-190 New students frequently 
use extra paragraph returns to add spaces 
between lines, or try unusual techniques 
to increase line spacing. The Space Before 
and Space After options are the most 
consistent methods for adding space 
between two paragraphs. You can also 
use the Leading options for adjusting 
line spacing. Additionally, you can use 
the baseline grid to set the line spacing. 
All of these can be used with paragraph 
styles, making it easy to make changes to 
multiple paragraphs in a single step.

Baseline Grid
Page 185 Because the both the baseline 
grid and leading control the amount 
of space between lines, you need to 
work with both options when using the 
baseline grid. You can set leading values 
to be equal to or less than the baseline 
grid option, otherwise type may skip to 
the next grid line, which may provide too 
much space between the lines.

Drop Caps
Page 197 Many users do not realize that 
Drop Caps are a paragraph attribute, 
and thus do not require you to select the 
characters you wish to use. Because of 
this, you can also use them in paragraph 
styles.

Word and Character Spacing
Page 199-201 Changing the kerning and 
tracking of headlines and larger type 
is often necessary. Make certain that 
your students understand the difference 
between kerning, which controls the 
space between character pairs, and 
tracking, which controls the space 
between multiple characters.

Tabs
Page 203 You can also prepare your 
students for tables (Lesson 8) as you 
discuss tabs. Tabs and tables are two 
methods for presenting complex text 
information.

Lesson 5: Working with Typography
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Questions
1 How can you easily apply a drop cap to 
all of the first characters used in multiple 
stories across a document?

2 If type is ignoring the baseline grid, how 
can you correct this situation?

Answers
1 You can create a Paragraph style and 
apply it to the first paragraphs where you 
want the drop cap to appear.

2  You may simply need to apply the 
baseline grid to the type from the 
Paragraph palette. But if the type has been 
told to align to the grid and it is working 
inconsistently, there is probably a leading 
value, a space before or a space after that 
is causing the text to not use the grid for 
alignment. Reduce or remove these values 
to have the grid work appropriately.
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This lesson provides a more detailed 
look at the methods for creating, saving 
and applying colors. Students may note 
that colors on screen are not necessarily 
consistent between computer monitors 
and printed output, which is addressed in 
the second portion of this chapter.

Saving Color
Page 216 The process is quite similar 
whether you are mixing CMYK colors, or 
saving spot colors, such as a PANTONE 
color. Encourage students to work 
primarily in the Swatches palette, as it 
provides one central location for creating, 
saving, applying, and modifying colors.

Customize Stokes
Page 220 While InDesign provides a great 
many stroke choices, you can also create 
customized stroke types by choosing 
Stroke Styles from the Stroke palette 
menu. These styles then become available 
in the Type drop-down menu in the 
Stroke palette.

Creating a Multiple Color 
Gradient
Page 221 You may want to have more 
advanced users create gradients with 
more than one color. You can click on the 
bottom of a gradient ramp, between the 
two stop colors to add an additional stop 
color. You can then change the additional 
color to meet your needs. This is covered 
in detail on page 231.

Colorizing Text
Page 228 Be careful when you first attempt 
to apply colors to text, as InDesign 
provides a number of options. You can 
apply color to the text fill or the stroke, 
just as you can with frames. And if you 
have a text frame selected, you need to 
use the controls in the Swatches palette to 
direct InDesign to colorize the text and 
not the frame.

Ensuring Consistent Color
Page 235 The implementation of color 
management has changed since earlier 
versions of InDesign, so even if you are 
familiar with color management concepts, 
you may wish to review this chapter.

Lesson 6: Working with Color
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Working Spaces
Page 242 Working spaces may vary if 
students are using different computers 
or if they are using different printers for 
proofing.

File Formats and Profiles
Page 247-249 Not all image file format 
support embedded profiles. Some that do 
support profiles include .psd, .ai, .tif and 
.jpg.

Questions
1 How can you edit the name or attributes 
of a color swatch?

2 How do you create a new color swatch?

3 How can you change a spot color to a 
process color?

4 What is the difference between color 
management and color correction?

5  What is a profile?

Answers
1 You can double-click on a color swatch 
to edit its name and attributes. Be careful 
that you do not have an object selected 
when you do this, as you may apply the 
color to the object at the time you click 
the swatch to edit it.

2 You can click the New Color Swatch 
button or choose New Color Swatch from 
the Swatches palette menu.

3 You can edit the swatch and change it 
to a Process color and change its Color 
Mode to CMYK and its Color Type to 
Process.

4 Color management helps you to 
achieve more consistent color, while color 
correction is used to fix color related 
problems.

5  A profile is used to identify the 
characteristics of a device – such as a 
scanner, a monitor or an output device. 
The profiles are used by InDesign to 
render an image so that when it is viewed 
on screen or on a proof it more closely 
resembles the final product.
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Lesson 7: Working with Styles

Styles are a critical feature for any docu-
ment that uses repetitive formatting, 
especially longer documents. Too often 
styles are under utilized by students, and 
you should encourage your students to 
gain a firm grasp of the concepts and fea-
tures for character, paragraph, and object 
styles.

Object Styles
Page 265 Object styles are a new feature 
for InDesign and are a new concept in 
page layout software. They allow users to 
save formatting applied to frames - in-
cluding formatting applied to text inside 
of a frame.

Character Styles
Page 270 Character Styles serve as the 
foundation for text styles. Character 
Styles can be used for the easy applica-
tion of multiple attributes–like font, size, 
and style. You can also create a character 
style to easily apply a single attribute - like 
Bold or Italic. When creating a Character 
Style, any formatting attribute not explic-
itly identified in the New Character Style 
window will remain as-is after the ap-
plication of the style. So a single style that 
applies the Bold attribute can be used to 

create Minion Pro Bold and also Adobe 
Garamond Pro Bold (providing that both 
of these fonts are installed). 

Nested Styles
Page 282-285 If your paragraphs always 
start with a certain formatting pattern, 
you can combine character and paragraph 
styles together to build a nested style. 
Nested Styles allow you to automatically 
style the first several words or characters 
of a paragraph using a character style, 
then format the remaining portion of a 
paragraph using a paragraph style. The 
formatting occurs in a single click. If your 
students are advanced, you may want to 
have them add multiple character styles 
as a nested style.

Updating Styles
Page 286 You can update character, para-
graph, and object styles using the same 
technique.

Loading Styles
Page 288 If you’ve already created styles 
in another document, you can import 
them into another InDesign file using the 
Load command from the palette menu.
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Questions
1 How do character styles differ from 
paragraph styles?

2 When applying a character style, what 
steps are necessary, and how does this 
differ from applying a paragraph style?

Answers
1 Character styles include only character 
attributes (font, size, color, scaling, 
kerning, etc.)–the attributes that are 
located in the Character palette and not 
those located in the Paragraph palette

2 When applying a character style 
you must first highlight the text to be 
formatted. Only the highlighted text is 
styled when applying a character style. 
Alternatively, paragraph styles apply 
formatting to an entire paragraph, 
even if  the cursor is only inserted in 
the paragraph. No text needs to be 
highlighted when applying a paragraph 
style.
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By default InDesign links to graphic files 
that are placed in an InDesign layout. 
This lesson provides a foundation for 
managing imported graphics using the 
Links palette and also using the Library 
for handling frequently used objects.

Missing and Modified Images
Page 299-303 The links palette shows all 
objects that have been imported into a 
file that might be needed for printing. 
Watch for yellow triangles, which indicate 
images that may have changed since 
the time they were imported and red 
stop signs, which indicate that InDesign 
can no longer locate the image that was 
imported. A file should not be printed 
or exported if it has missing or modified 
images. By default, text files are not listed 
here, as they are not needed for printing. 
However, you can change this option.

View Quality
Page 304 The Typical setting is the best 
option unless you have a need to see the 
original, high-quality artwork. When 
you are done viewing artwork at a higher 
resolution, you can set it back to the 
Typical mode.

Clipping Paths
Page 305-308 You can also use work paths, 
clipping paths and alpha channels – all 
built into a graphic-  to define the visible 
portion of an image.

Alpha Channels
Page 310-313 This section requires the 
use of Photoshop. If you are teaching a 
class focused on typography, you may 
want this section to be optional. The 
features discussed in this section are 
good for users to understand, as the 
image preparation in Photoshop impacts 
the ability to display a silhouette within 
InDesign.

File Formats
Page 314, 320 While we work with .psd, 
.ai and .pdf files in this lesson, you can 
use virtually any file format. InDesign 
supports formats such as TIFF, EPS and 
JPEG, to name a few. The native file 
formats offer some advantages, such as 
the ability to work with a Photoshop file 
that includes layers.

Lesson 8: Importing and Linking 
Graphics
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Questions
1 Why is it important for links to graphic 
files to be maintained?

2 What is the benefit of a clipping path or 
alpha channel?

Answers
1 Because InDesign relies on the original 
source file for printing, most graphics will 
not print correctly (nor will they export 
correctly to PDF) if the original source 
file can not be located.

2 Creating a clipping path or alpha 
channel lets you save selections and 
determine which portions of an image 
will print. Because these are most-often 
created using an image-editing program, 
such as Photoshop, you can print the 
image exactly as it was intended by the 
designer or photographer.



22
Adobe InDesign CS2 Instructor Notes

Tables make it easier to present large 
amounts of data. Tables are created within 
text frames, and can be easily controlled 
through the Tables palette and the Table 
menu. You can also use the Control 
palette to manipulate tables. You can 
import tables from Excel and Microsoft 
Word or you can convert existing text to 
a table.

Importing Tables
Page 332 You can import tables created 
in Microsoft Word or Excel directly into 
InDesign. You can choose the import 
options to select which Excel sheet is 
being imported and even choose a cell 
range.

Cell Attributes
Page 336 Table cells can be formatted 
independent of the rest of the table. 
Individual cells are formatted using the 
Cell options. You can format all of the 
cells by using Table options. 

Table Palette
Page 341 While the Table palette provides 
a comprehensive set of options for 
creating and manipulating tables, you can 

also use the Control palette for many of 
the options covered in this section. You 
may want to have your students learn the 
concepts with the Table palette and then 
let them experiment with the Control 
palette.

Graphics in Tables
Page 341 Graphics placed into a table are 
in-line and need to be copied and pasted 
into the cell or they are imported while 
you have a text insertion point (blinking 
cursor).

Table Headers
Tables can be linked across multiple 
text frames, and table headers appear 
at the top of each frame containing the 
table. You can have your more advanced 
students experiment with creating tables 
that span multiple text frames, and add 
table headers that appear in each frame.

Questions
1 How are graphics imported into a table?

2 How do you easily select an entire row, 
a column or the entire table?

Lesson 9: Creating Tables
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3 How do you add or delete rows and 
columns?

Answers
1 You can choose the Place command 
when the cursor is inserted in a table cell, 
or you can choose the Paste command 
after copying a graphic.

2 You can move your mouse to the 
outside portion of a row or column and 
click when the black arrow appears. You 
can also move your cursor to the upper 
left corner of a table and click when the 
arrow appears to select the entire table.

3 You can add or delete rows by entering 
a larger or smaller number in the rows 
or columns section of the Tables palette. 
You can also choose the Insert or Delete 
commands from the Table palette menu.
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InDesign supports transparency whether 
it is created in another program, such 
as an image imported from Photoshop, 
or created using InDesign.  This lesson 
shows some of the ways in which 
transparency can be added to objects 
using InDesign.

Colorizing Black and White 
Images
Page 355 As with the exercise in the last 
lesson, you can colorize grayscale images. 
Note that you can colorize the image and 
you can also colorize the background 
color of the frame containing the image.

Pen Tool Shapes
Page 361 You can have your more 
experienced users create another spiral, 
similar to the one on this page using the 
pen tool.

Drop Shadow
Page 367 A drop shadow can be applied 
to images or text, as it is an attribute of 
the frame. For the text to have a visible 
shadow, the frame color needs to be set to 
none.

Questions
1 What is the advantage of creating drop 
shadows using InDesign?

2 Why is it important for a page-layout 
program to support transparency?

Answers
1 You can avoid returning to Illustrator or 
Photoshop to create drop shadows. You 
can also create fully editable type, such 
as headlines, using drop shadows within 
InDesign. While you can achieve similar 
results in both Photoshop and Illustrator, 
this involves making the element and 
importing into InDesign. Any edits need 
to be done in these other programs.

2 Because transparent elements can be 
created using Photoshop and Illustrator, 
it is important that page layout programs 
understand how to handle these items. 
Images with feathered edges or pictures 
with transparent elements (such as a 
glass) can only be successfully used in a 
page layout program that can recognize 
transparency.

Lesson 10: Working with 
Transparency
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You can use books to more easily manage 
long documents. It becomes impractical 
to have one document that is hundreds 
of pages in length. Using the book feature 
you can break longer documents into 
sections, and add each section to the 
Book palette. You can create multiple 
book files, which reference individual 
InDesign files. This chapter is focused 
entirely on long-document features of 
InDesign.

Book Palette
Page 374-376 The book file links to the 
individual InDesign files that have been 
added to the book. The sequence of the 
files in the palette is important, as it 
determines page numbering if automatic 
page numbering is being used in any of 
the files. You can use the synchronization 
options in the palette menu to determine 
how synchronization of the files occurs-
establishing one document as the source 
for all definitions of styles and colors. 
Multiple individuals can work on various 
portions of a book at the same time, 
although each file can only be open 
for editing by one individual at a time. 
However, the same book palette can be 
opened by several users concurrently.

Table of Contents
Page 377 You can create a custom set of 
styles for the text in a table of contents 
before you build the TOC. This lets you 
choose the style when building the TOC, 
and have it automatically formatted. 
InDesign also includes some default TOC 
styles that become available when you 
create the TOC.

Index
Page 382 You can also create index topics, 
as opposed to references. Use this option 
to determine what will be in the index, 
and then create the references to conform 
to the topics you have added.

Lesson 11: Working with  
Long Documents
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Questions
1 Are index entries automatically 
updated?

2 How do you specify that a TOC and 
Index will include all chapters in a book?

3 Why create a book?

Answers
1 Index entries are not automatically 
updated. You must add individual entries 
or use the add all option to have them 
added.

2 You must check the box in the Index 
palette for it to include book chapters. 
For you to include all book chapters in 
a TOC, use the checkbox in the TOC 
dialog box.

3 Books make it easy to work with longer 
documents and to make certain that 
styles and colors are defines consistently 
across multiple files.
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As a page-layout program, the primary 
destination for most files will be a printed 
product. Whether this is a brochure, 
package design, or newsletter, you need to 
know how to print effectively and check 
the file for possible errors. A large and 
ever-growing number of print service 
providers accept InDesign files, and this 
chapter covers the tools for successfully 
printing with InDesign.

You can also create PDF files for a variety 
of purposes—including distribution on-
line and for high quality printing.

Preflight
Page 393 This step is essential before 
handing-off a file. Whether you are 
delivering the file to a commercial printer 
or a colleague, this option confirms that 
all assets necessary for printing or editing 
the document are available. The preflight 
step is run automatically whenever you 
choose the Package command.

Package
Page 396 Packaging a file is also a great 
way to create an archived version of a 
document, as it includes all necessary 
elements.

PDF Quality Options
Page 398 Note that there are a variety of 
settings that control the quality of the 
final PDF document. It is important to 
select a setting that matches your needs 
for the final PDF. A high quality PDF 
might be suitable for sending to a printer, 
but might be impractically large to post 
on-line.

Separation Preview
Page 399 You can confirm the actual 
printing breakdown of a file to confirm 
that it is exactly as you intended by using 
the Separation Preview palette.

Lesson 12: Printing and  
PDF Exporting



28
Adobe InDesign CS2 Instructor Notes

Questions
1 How do you save your print settings?

2 How can you confirm what ink 
separations will be printing?

3 What are some of the advantages of 
InDesign’s integrated PDF export?

4 Are all PDF files the same quality?

Answers
1 You can create a Print Preset.

2 You can use the Separation Preview or 
use the Ink Manager.

3 Because you do not need to generate 
PostScript files and use Acrobat Distiller, 
you tend to create PDF files much faster. 
The integrated PDF export also provides 
for enhanced PDF options, such as the 
inclusion of multimedia elements and 
buttons that would otherwise not be 
possible.

4 You can choose from a number of 
preset options that determine the quality 
(and file size) of the resulting PDF. There 
are high quality and low quality PDF 
options that are available, so all PDF files 
are not the same. In fact, you may need 
to export a PDF file multiple times if you 
intend to distribute the file on-line and 
also for printing.
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Lesson 13: Using XML

Larger organizations are increasing using 
XML to repurpose the content that they 
create. InDesign’s integrated XML import 
and export capabilities allow you to either 
import XML that was created previously, 
or convert your document contents into 
XML that can be re-used in other forms–
whether print or on-line.

This chapter covers the basics of working 
with InDesign’s XML capabilities. 

Importing and Applying  
XML Tags
Page 417 Most XML workflow require 
the tagging of objects, and the tags must 
be consistent from one document to 
the next. For this reason, the tags are 
generally created once and then imported 
and applied to each document. This keeps 
the tag name.

Structure
Page 421 Because the structure sequence 
indicates the order and relationship of the 
elements in the layout, it is important to 
pay close attention to the way in which 
items are listed. Recipients of the XML 
may not have the layout as a reference, 
so they need to clearly understand the 
relationship of items by viewing their 
structure in the XML file.

Snippets
Page 429 While technically these are XML 
items, you should encourage students to 
take advantage of snippets the way they 
might use an object library. Snippets 
can be used with no knowledge of XML 
as a simple way to share items between 
documents.

Questions
1 Why export XML?

2 Do designers generally create their own 
XML tags?

Answers
1 XML provides a format for sharing 
document content so it can be reused 
in other formats. The exported XML 
is independent of the layout, so it is 
important for the structure and tags to 
accurately reflect the layout.

2 Tags are generally created once and 
then imported, this keeps the tags 
consistent between documents.
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Lesson 14: Working with 
Adobe Bridge and Version Cue
Using Adobe Bridge 
Page 434 Bridge is one of the most 
significant enhancements to the CS2 
applications. You may actually want to 
teach this section first, providing students 
with an overview  of this effective way to 
manage their files. Because Adobe Bridge 
can be used in place of the traditional File 
> Open command (or even the traditional 
File > Place command), it is a unique 
way for users to work. Create additional 
exercises where users drag and drop items 
from the bridge into their layout–such 
as Photoshop or Illustrator files, or even 
word processing files.

Using Version Cue
Page 436 Version Cue is more appropriate 
for advanced users who are already 
familiar with InDesign essentials and 
now need to manage their documents 
and track their revisions. Version Cue 
and Bridge are separate applications, 
and do require additional memory and 
processing power on your computers. 
Version Cue must be installed as a part 
of the Creative Suite. If you only installed 
InDesign, you will not have access to 
Version Cue.

If you are teaching in a computer lab with 
older computers, Version Cue may be too 
intense an application to run at the same 
time as other Creative Suite applications, 
and you may notice a degradation in 
performance if it is running. If this 
occurs, you can turn off Version Cue 
using the Control Panels (Windows) or 
System Preferences (Mac OS).
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Questions
1 When can you use Adobe Bridge?

2 When would Version Cue be 
appropriate?

Answers
1 Use Adobe Bridge to find files, 
import them, and open them. Because 
Adobe Bridge can also provide preview 
information and metadata, it is more 
useful than the traditional File > Open 
command or even browsing files through 
the operating system.

2 Version Cue is useful for designers 
who need to create multiple versions 
of a document or when a document is 
going through multiple revision cycles 
and you want to keep past versions. You 
do not need to have multiple users to 
take advantage of Version Cue–it can be 
equally as effective for a single designer 
keeping track of file versions in an 
involved project.


